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English

WARNING

Make sure you download any pictures from your camera BEFORE removing
or changing batteries, unless you have been using an SD card rather than the
internal memory for photo storage. We recommend you download all current
photo files for safekeeping before storing the ImageView away if you are not
using an SD card in the camera, in case the batteries become depleted during
extended storage.

WARNING

Do NOT look directly at the sun through your binoculars.
Doing so may cause permanent eye damage.

NOTE: To reset the camera if you experience problems or if the display becomes
unresponsive, remove the batteries for at least one minute, then re-install them.
This may result in the loss of photos/videos stored in the internal memory.
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Congratulations on your purchase of the Bushnell ImageView®

binocular! The Bushnell ImageView binocular takes the technology

of digital photography and combines it with a high-quality compact
binocular. This allows you to observe sporting events, wildlife, scenic
vistas or anything you would normally use a binocular for, and then
save the image in a built-in attached digital camera. You can then
download these images to your computer and e-mail them to your
friends and family, print out the picture using the included software or
save them in a photo album for future use. Before using the product,
please read the instructions contained in this manual and take time
to familiarize yourself with the different parts and features of the

product.
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Setup and Basic Operation

1. The camera is powered by two AAA alkaline, lithium, or NiMh batteries (not included).
Insert batteries into the compartment, with the springs in contact with the negative (flat) end
of each battery. A power meter on the lower right of the display indicates battery condition.
2. Insert an SD card ("upside down" with metal contacts facing up) in the slot if greater
storage is desired. You may use SD cards (not MMC cards) up to a maximum 1 GB capacity.
The camera has 16 MB of internal memory which can hold over 100 photos, so a card may not
be necessary. However, the internal memory contents will be lost if the batteries are removed or
die-unlike photos stored on an SD memory card. A 256MB, 512 MB or 1GB standard speed
SD card is available in most consumer electronics or computer stores and a is good choice for
your ImageView, especially if you will always use "Hi" resolution.

3. Press and hold the MODE button until the power LED comes on. The camera will turn
off automatically after about one minute if no buttons are pressed. Note: when the camera is
connected to a computer via the supplied USB cable, the camera will power on automatically, and
draw power from the computer with no battery drain.

4. Hold the ImageView steady and press SNAP to take a picture (or start/stop shooting a
video, when the camera is in video mode). The camera focus is preset to take sharp photos from
appoximately 35 feet to infinity.

5. When using a tripod, you can help avoid the effects of camera shake by plugging the
supplied remote shutter release into the jack next to the SD card slot, and using the button on
the remote rather than SNAP to take photos.

7
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Using the Operational Modes/Setting Date & Time

‘The ImageView will imprint the date and time in the bottom right corner of your photos. To
set the correct date and time, after turning on the camera, press and hold both the MODE and
SNAP buttons at the same time, until the display begins to flash. The display now shows the
last two digits of the year. Press the MODE button to move the cursor to the second digit if
necessary. Press the SNAP button to advance the digit to the current year ("07" for 2007, etc).
‘Then press MODE to go to the next number, which is the month. Again, use SNAP to change
this to the current month. Following the month display is: date, hour (24hr format), minute,
and second-continue to set these following the same process using the MODE and then SNAP
buttons. When you have completed all of the date/time settings, the display will stop flashing
and return to normal. Note that you will need to reset the date/time after replacing batteries.

Your ImageView is already set to high resolution and quality right out of the box, and it is
not necessary to use the MODE settings and make any changes to get good results by simply
pressing the SNAP button to take photos. However, as you might want to shoot a video clip,
delete one or more previous photos, or explore other options, we recommend you review the
available mode options listed on the following pages. Briefly pressing the MODE button will
step through these operational modes in the listed order, and you will see the icon for each
mode along with its current setting on the display. Use the SNAP button to select the desired
setting for any mode. If you make no changes, and the SNAP or MODE button is not pressed
within 5 seconds, the camera will return to normal operation and display.

8
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Using the Operational Modes (Bold indicates default settings)

Mode Icon Settings Description
Video Video OFF, ON Select "ON" instead of "OFF" to put the camera
Camera in video mode. Wait several seconds for the camera

to automatically return to the normal display, then
begin shooting by pressing SNAP. The counter
will show elapsed time. Press SNAP again to
stop shooting. The counter will advance by one,
indicating the video file has been saved. Return to
the video mode setting and select OFF to reset the
camera to still photo mode.

Quality HqorLq High, Low Select "Hi" (recommended) or "Lo" quality to
choose the amount of file compression, which affects
the size of the photo file. "Lo" allows more photos
to be stored in memory, but at reduced quality.

Resolution Hior Lo High (2.1mega Select "Hi" (recommended) or "Lo" resolution,
pixels), Low based on your preference for better looking photos
(640x480 pixels) (Hi) or being able to take a greater number of
photos (Lo).
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Using the Operational Modes

Mode Icon Settings Description

Line Frequency | 60 or 50 60 Hz, 50 Hz Set to match the AC power frequency (cycles) of
your country. This ensures that stills and videos shot
under fluorescent lighting appear normal.

Continuous CT OFF, 3,5 Select 3 or 5 frames to shoot a rapid series of photos
instead of a single frame when SNAP is pressed
(in normal still photo mode). To cancel, enter this
mode again and select OFE

Memory Access | MEM Sto (USB Mass Select "Sto" to access the internal or card memory
Storage), PC (USB | when the camera is connected to a computer with
Camera) the USB cable. "PC" allows the camera to be

used as a live USB/PC camera (note that the 8x
magnification and lack of close focus capability
limits usefulness in most size rooms)

Delete Last LSt+Trash None-press SNAP | Select this mode and press SNAP to delete only the
Can to delete the last last photo or video you took. The counter will go
photo or video down one number.
10
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Using the Operational Modes

Mode Icon Settings Description
Delete All ALL+Trash | None-press SNAP | Select this mode and press SNAP to erase the entire
Can to delete all photo | memory contents (the counter resets to zero).
and video files Use this after downloading your files, to clear the

memory so you can take new photos. If "Delete All"
is selected accidently, simply wait a few seconds and
the camera will return to normal operation.

Format For+Trash None-press SNAP | If you are using a new SD card, or one previously
Can to format card or used in other devices, we recommend you select
internal memory Format and press SNAP before you start taking

photos, to the card is setup with the correct data file
system for this camera. Note that formatting a card
erases its contents-please be sure you have backed up

any previous files first.

Self-Timer Clock OFF or On Photo is taken after a 10 second delay when SNAP
is pressed (in normal still photo mode.) This can be
used to avoid accidently shaking the camera when
the SNAP button is pressed. If the remote shutter
cable is available, it should be used instead of the
self timer when the camera is tripod mounted. The
timer automatically cancels after use.

11
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USING THE IMAGEVIEW WITH YOUR COMPUTER:

1. The camera will be recognized as a USB mass storage device (if it is set to "STO" and not "PC"),
which means no special drivers are required for all operating systems later than Windows 98 (Me,
2000, XP, Vista.) Mac OS 9 and OSX are also compatible. If you have a PC running Windows 98,
you must install the driver found on the included CD-ROM BEFORE CONNECTING THE
CAMERA TO YOUR PC.

2. If you have a computer OS as listed above that is USB mass storage compliant, a new disc icon will
appear in Windows Explorer (under “My Computer”) as a new “Removable Disc” after plugging in
the USB cable from the Imageview. Mac users will see the new disc device appear on their desktop.
Clicking on the new disc icon will show the contents, a folder named “DCIM.” The image folder
inside this contains your photos, stored as JPEGs (,jpg file format). They may then be viewed,
edited, renamed and saved using any photo or graphics software that accepts .jpg files. If you do not
have software that will open .jpg files, you should install Roxio Photosuite 5 (Windows 98, 2000 or
XP only) from the included CD-ROM. See “Software Installation” for instructions.

3. After you have copied or opened and saved the photo files to your computers hard drive, you
may disconnect the Imageview camera (NEVER disconnect the camera while files are still being
transferred to your computer.) Before disconnecting, you should “eject” or stop the "removable disc”

representing the camera to avoid an error message (not necessary with Windows XP).

4. See the following pages for full step by step instructions to download your photos.

12
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System Requirements (Minimum)

OS: Windows® 98/98SE/2000/ME/XP/Vista (PhotoSuite 5 is not compatible with Vista)

CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® III 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)

SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color

200 MB available hard disk space (if installing PhotoSuite)

Internal USB Port

Software Installation

If you are using Windows 98, you must install drivers before connecting the camera to your PC. Insert the CD-ROM
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “Install Driver”, then
follow the directions. After installation, restart your computer. Windows 2000, ME, and XP do not require drivers,
as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were stored on
an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer, you may
install Roxio PhotoSuite® from the CD-ROM. Be sure to read the “Release Notes” completely, noting any tips or
potential issues relevant to your PC configuration and OS.

Note: With Windows Vista, you may encounter error or warning messages (‘file missing”, etc) while

installing PhotoSuite 5, but clicking “OK” and proceeding should allow the installation to finish.
CAUTION: Make sure you download all photos/videos from your

camera's internal memory before removing the batteries.

Transferring The Photos & Videos to Your PC - Step by Step
1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Connect the supplied cable to the ImageView’s USB port, then directly to a main USB port on your computer-do
not use front panel/keyboard USB ports or unpowered “hubs”.

13
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Transferring The Photos & Videos to Your PC continued

3. The LCD display will indicate “STO”, and the ImageView will be recognized as a standard “USB
Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your
hard drive, just as if they were stored on an external hard drive or a CD-ROM. (Note for Mac users: you
may need to select "STO" memory access and plug in the ImageView while its LCD still displays "STO"
for it to appear on the Mac desktop as an "Untitled" disk. See "Using the Operational Modes")

4. (This step is not required with Windows XE, simply use the options in the pop-up window to view, copy
or edit your photos). Open My Computer or Windows Explorer. The camera will be seen as a new
“Removable Disk” with an unused drive letter assigned to it. Double click this new “Disk” icon, open
the “DCIM” folder inside, then the folder(s) inside that (“100MEDIA” ,etc). Your photos/videos are
the files inside-they have the prefix “DSC” followed by a 4-digit number, as scen earlier on the camera’s
display when you review photos. Single clicking any file should show a small preview image.

5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then
“Edit>Copy to Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My
Pictures”, or create a new folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the
photo files you want.

6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000
may produce a screen warning that you have disconnected a USB device without stopping or ejecting
the “disk” first (your photo files will not be harmed). If so, check the box that adds an icon to your
system tray or taskbar. Then next time you finish transferring photos, you can click that icon first, and
“Stop the USB Mass Storage Device” before disconnecting the camera. (On Mac computers, you should
“eject” the untitled “disk” that appeared on your desktop when the camera was connected.)

14
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Transferring The Photos & Videos to Your PC continued

7. You're now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder
where you stored the photos earlier. If you are using PhotoSuite, select File>Open Photo, then use the “Look in”
pull down menu at the top of the Open window, select “My Computer”, select your hard drive, and double click
any photo in the folder where you copied the files from the camera. It is also possible to open and work with your
photos directly from the ImageView while it is still connected.To do this with PhotoSuite, first follow steps 1-3,
then open PhotoSuite, select File>Open Photo and use the “Look in” menu to select My Computer, then select
the “Removable Disk”, and open the folders inside until you get to the JPEG photo files. If you choose to work
this way, from a connected camera, be sure that you save the photo (when you are done editing) to your hard drive,
and not the camera’s memory or card. To do this in PhotoSuite, after clicking “Done”, answer “Save Changes?”
with “Yes”, but then answer “Replace Existing File”? with “No” and use the “Save As” dialog box to save the edited
photo in a folder on your hard drive (“Save In>Local Disk”), not the “Removable Disk” (camera).

8. If you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color
of your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium
resolution version for email or inserting into documents. When you are ready to save your edited file, you may
want to use “Save As” and give it a more descriptive name than “DSC___". Doing this also preserves the original
file as a backup to reopen and re-edit later. Make sure you have successfully transferred all the photos you wanted
to save before using “Delete All” on your camera to make room for new images.

15
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BINOCULAR INSTRUCTIONS

Your Bushnell binocular is a precision instrument designed to provide many years of pleasurable
viewing. This portion of the booklet will help you achieve optimum performance by explaining how
you can adjust the binocular to your eyes, and how to care for this instrument. Read the instructions
carefully before using your binocular.

EYE ADJUSTMENTS (Figure 1)

How to Adjust For Distance Between Your Eyes

The distance between the eyes, called “interpupillary distance,” varies from
person to person. To achieve perfect alignment of lens to eye, follow these
simple steps.

INTERPUPILLARY

1. Hold your binocular in the normal viewing position.
2. Grasp each barrel firmly. Move the barrels closer together or further apart
until you see a single circular field. Always re-set your binocular to this position before using.

How to Adjust For Individual Eye Strength
As individual eyesight varies from one person to another, most Bushnell binoculars have a diopter setting

feature which allows you to fine-tune the binocular to your vision. Follow the focusing instructions below
for your type of binocular.

16
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FOCUSING

1. Adjust interpupillary distance. (Figure 1)

2. Set the “diopter setting” (Figure 2) to zero and view a distant object.

3. Keep both eyes open at all times.

4 Usmg a lens cover or your hand, cover the obJectlve (front) lens of the

DlUl’l}:I\ \l:l TING

the right side. (The left side on zoom models.)

5. Using the center focus wheel, focus on a distant object with fine detail
(e.g., brick wall, tree branches, etc.) until it appears as sharp as possible.

6. Uncover the objective lens on the diopter side, cover the other objective lens, then view the same object.

7. Using the “diopter setting” adjustment ring, focus the same object being viewed. Caution should
be used as over turning or forcing the diopter eyepiece can cause damage or cause the eyepiece to
break away from the chassis.

8. Your binocular should be adjusted for your eyes. Focus at any far or near distances can now be
attained simply by turning the center focus wheel. Make a note of the diopter setting for your eyes
for future reference.

EYECUPS (Figure 3)

Your Bushnell binocular is fitted with rubber roll-down eyecups designed for
your comfort and to exclude extraneous light. If you wear sun/eyeglasses, roll
down the eyecups. This will bring your eyes closer to the binocular lens thus
providing improved field of view.

ROLL-DOWN EYECUPS

17
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INSTRUCTIONS FOR CARE OF BINOCULARS

Your Bushnell binocular will provide years of trouble-free service if it receives the normal care you would
give any fine optical instrument. The Imageview is not waterproof, and should not be exposed to any
source of moisture. Water damage is not covered by the warranty.

1. Ifyour binocular has roll-down, flexible eyecups, store it with the eyecups up. This avoids excessive
stress and wear on the eyecups in the down position.

Avoid banging and dropping.

Store in a cool, dry place.

WARNING: Looking directly at the sun with your binocular can cause permanent eye damage.
Never expose your ImageView binocular to any type of excessive liquid or fluid, as it is not water/
fogproof.

Take the batteries out of your ImageView if you are not going to use it for a long period of time. (Make

VU BN

a

sure you download any pictures from your camera before you remove the batteries out of the camera.)

CLEANING

1. Blow away any dust or debris on the lens (or use a soft lens brush.)

2. To remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular motion. Use of
a coarse cloth or unnecessary rubbing may scratch the lens surface and eventually cause permanent
damage. A “microfiber” cleaning cloth (available at most photo dealers) is ideal for the routine
cleaning of your optics.

3. For a more thorough cleaning, photographic lens tissue and photographic-type lens cleaning fluid
or isopropyl alcohol may be used. Always apply the fluid to the cleaning cloth — never directly on
the lens.

18
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TWO-YEAR LIMITED WARRANTY

Authorized Service Department.

Name and address for product return
An explanation of the defect
Proof of Date Purchased

a2

Bushnell Outdoor Products
Aun.: Repairs

8500 Marshall Drive
Lenexa, Kansas 66214

INU.S.A. Send To: IN CANADA Send To:

Your Bushnell” product is warranted to be free of defects in materials and workmanship for two years after
the date of purchase. In the event of a defect under this warranty, we will, at our option, repair or replace
the product, provided that you return the product postage prepaid. This warranty does not cover damages
caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell

Any return made under this warranty must be accompanied by the items listed below:

A check/money order in the amount of $10.00 to cover the cost of postage and handling

Product should be well packed in a sturdy outside shipping carton, to prevent
damage in transit, with return postage prepaid to the address listed below:

Bushnell Performance Optics
Aun.: Repairs

25A Bast Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

For products purchased ousside the United States or Canada please contact your local dealer for applicable
warranty information. In Europe you may also contact Bushnell at:

Bushnell Germany GmbH
European Service Center
Mathias-Briiggen-Str. 80
GERMANY

D- 50827 Kéln

Tel: +49 221 995568-0
Fax: +49 221 995568-20

‘This warranty gives you specific legal rights.
You may have other rights which vary from country to country.
©2007 Bushnell Outdoor Products

CC Note:
[This equipment has been tested and found to compl,
with the limits for a Class B digital device, pursuan]
to Part 15 of the FCC Rules. These limits are designed|
to provide reasonable protection against harmful
interference in a residential installation. This equipmentf
generates, uses and can radiate radio frequency energy]
and, if not installed and used in accordance with the}
linstructions, may cause harmful interference to radiof
communications. However, there is no guarantee thatf
interference will not occur in a particular installation. I
this equipment does cause harmful interference to radiol
or television reception, which can be determined b;
turning the equipment off and on, the user is encouraged}
o try to correct the interference by one or more of thel
following measures:
| Reorient or relocate the receiving antenna.
 Increase the separation between the equipment and receiver,
- Connect the equipment into an outlet on a circuif
different from that to which the receiver is connected.
| Consult the dealer or an experienced radio/T'
technician for help.

[The shielded interface cable must be used with thel
lequipment in order to comply with the limits for a digital}

[device pursuant to Subpart B of Part 15 of FCC Rules.

FE€ C¢€

Specifications and designs are subject to change
without any notice or obligation on the part of the
manufacturer.
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Espaiiol
ADVERTENCIA

Asegtirese de descargar las fotos de su cdmara ANTES de quitar o cambiar las
pilas, a menos que haya estado usando una tarjeta SD en vez de la memoria
interna para almacenar las fotos. Recomendamos descargar todos los archivos
de fotos actuales para almacenarlos antes de guardar la ImageView si no estd

usando una tarjeta SD en la cdmara, en caso de que las pilas se agoten durante el
almacenamiento prolongado.

ADVERTENCIA

NO mire directamente al sol por los binoculares.
Al hacer esto se pueden causar dafios permanentes de los ojos.

NOTA: Para reajustar la cdmara si tiene problemas o si la pantalla no responde,
quite las pilas durante al menos un minuto y después vuelva a instalarlas. Esto
puede resultar en la pérdida de fotos/videos guardados en la memoria interna.

20
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iEnhorabuena por la compra de los binoculares ImageView® de

Bushnell! Los binoculares ImageView de Bushnell adopta la

joyvdsy

tecnologia de fotografia digital y la combina con unos binoculares
compactos de alta calidad.

Esto permite observar acontecimientos deportivos, fauna y flora,
vistas escénicas o cualquier cosa para la que normalmente usaria
binoculares y después guarde la imagen en una cdmara digital
conectada integrada. Después puede descargar estas imdgenes
en su computadora y enviarlas por correo a sus amigos y familia,
imprimir la foto usando el software incluido o guardarlas en un
dlbum de fotos para uso futuro. Antes de usar el producto, lea
las instrucciones contenidas en este manual y témese el tiempo
para familiarizarse con las diferentes piezas y caracteristicas del

producto.

21
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Guia de piezas de la cdmara
y de los binoculares

Pantalla
LCD

Botén Snap

(instantdneas) Foco de los
binoculares
Botén (.ie modalidad/ Lente de la
encendido cimara
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Configuracién y operacién bdsica

1. La cdmara estd alimentada por dos pilas AAA alcalinas de litio o NiMh (no incluidas).
Introduzca las pilas en el comportamiento, con los resortes en contacto con el extremo negativo
(plano) de cada pila. El medidor de corriente de la parte inferior derecha de la pantalla indica la
condicién de las pilas.

2. Introduzca una tarjeta SD (“boca abajo” con los contactos de metal apuntando hacia arriba)
en la ranura si se desea un mayor almacenamiento. Puede usar tarjetas SD (no tarjetas MMC)
hasta una capacidad mdxima de 1 GB. La cdmara tiene una memoria interna de 16 MB que
pueden contener mds de 100 fotos, por lo que tal vez una tarjeta no sea necesaria. No obstante,
se perderd el contenido de la memoria interna si se sacan las pilas o se agotan, a diferencia de las
fotos almacenadas en una tarjeta de memoria SD. Se dispone de una tarjeta SD de velocidad
estandar de 256MB, 512 MB o 1GB en la mayoria de las tiendas de componentes electrénicos
del consumidor o de computadoras y es una buena opcién para su ImageView, especialmente si
va a usar siempre una “alta” resolucién.

3. Pulse sin soltar el botén MODE (modalidad) hasta que se encienda el LED de encendido. La
cdmara se apagard automdticamente después de un minuto si no se pulsa ningtin botén. Noza:
cuando la cdmara esté conectada a una computadora por medio de un cable USB suministrado, la
cdmara se encenderd automdticamente y absorberd corriente de la computadora sin drenar las pilas

4. Mantenga fija la ImageView y pulse SNAP para tomar una foto (o iniciar/detener un video,
cuando la cdmara esté en la modalidad de video). El foco de la cdmara estéd prefijado para tomar
fotos nitidas desde aproximadamente 10,5 m hasta el infinito.

5. Cuando se use un tripode, puede ayudar a evitar los efectos de movimiento de la cdmara
enchufando el dispositivo de desconexién del obturador remoto en el jack junto a la ranura de la
tarjeta SD, y usando el botén del control remoto en vez de SNAP para tomar las fotos.

23
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Uso de las modalidades de operacién/Ajuste de la fecha y de la hora

La ImageView imprimird la fecha y la hora en la esquina inferior derecha de sus fotos. Para fijar
la fecha y la hora correctas, después de encender la cdmara, pulse sin soltar los botones MODE
y SNAP al mismo tiempo, hasta que empiece a destellar la pantalla. La pantalla muestra ahora
los dos ultimos digitos del ano. Pulse el botén MODE para mover el cursor al segundo digito
si es necesario. Pulse el botén SNAP para hacer avanzar el digito al ano actual (“07” para 2007,
etc).

Después pulse MODE para ir al siguiente niimero, que es el mes. Nuevamente, use SNAP
para cambiar esto al mes actual. Después de la visualizacién del mes aparecen: fecha, hora
(formato de 24 horas), minutos y segundos. Contintie fijando éstos siguiendo el mismo
proceso usando los botones MODE vy después SNAP. Cuando haya completado todos los
ajustes de fecha/hora, la pantalla dejard de destellar y volverd a ser normal. Observe que tendrd
que reajustar la fecha/hora después de reemplazar las pilas. Su ImageView ya estd fijada para
una alta resolucién y alta calidad justo después de sacarla de la caja, y no es necesario usar los
ajustes MODE y efectuar cambios para obtener los buenos resultados pulsando simplemente el
botén SNAP para tomar fotos. Sin embargo, como tal vez desee filmar un clip de video, borrar
una o mds fotos anteriores o explorar otras opciones, recomendamos que revise las opciones
de modalidad disponibles indicadas en las p4ginas siguientes. Al pulsar brevemente el botén
MODE se recorrerdn estas modalidades de operacién en el orden indicado, y se verd el icono de
cada modalidad junto con su ajuste actual en la pantalla. Use el botén SNAP para seleccionar
el ajuste deseado para cualquier modalidad. Si no efectia ningtin cambio, y no se pulsan los
botones SNAP 0 MODE en un plazo mdximo de 5 segundos, la cdmara volverd a la operacién
y pantalla normales.
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Uso de las modalidades de operacién (negrita indica los ajustes implicitos)

Modalidad | Icono Ajustes Descripcién
Video Cdmara de OFF (apagado), | Seleccione “ON” en vez de “OFF” para poner
video ON (encendido) | la cdmara en la modalidad de video. Espere

varios segundos para que la cdmara vuelva
automdticamente a la pantalla normal, y después
empiece a filmar pulsando SNAP.

El contador mostrard el tiempo transcurrido.
Pulse SNAP otra vez para dejar de filmar. El
contador avanzard de uno en uno, indicando
que el archivo de video se ha guardado. Vuelva
al ajuste de la modalidad de video y seleccione
OFF para reajustar la cdmara a la modalidad de

foto fija.
Calidad Hq (alta High (alta), Seleccione calidad “Hi” (recomendado) o “Lo”
calidad) Low (baja) para escoger la cantidad de compresién de
o Lq (baja archivos, lo que afecta el tamafio del archivo de
calidad) fotos. “Lo” permite almacenar mds fotos en la

memoria, pero con una calidad reducida.

Resolucién Hi (alta) o High (alta) Seleccione resoluciéon “Hi” (recomendada) o
Lo (baja) (2.1mega pixels), | “Lo”, basindose en su preferencia para obtener
Low (baja) fotos de mejor aspecto (Hi) o poder tomar un

(640x480 pixels) | mayor nimero de fotos (Lo).
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Uso de las modalidades de operacién (negrita indica los ajustes implicitos)

Modalidad | Icono Ajustes Descripcién
Frecuencia 60 6 50 60 Hz, 50 Hz Fije para hacer corresponder con la frecuencia de CA
de la linea (ciclos) de su pais. Esto asegura que las fotos fijas
y los videos filmados con luz fluorescente aparezcan
normales.
Continua CT OFF (apagado, Seleccione 3 6 5 cuadros para tomar una serie rapida
3,5 de fotos en vez de un solo cuadro cuando se pulse

SNAP (en la modalidad de foto fija normal) Para
cancelar, entre en esta modalidad nuevamente y
seleccione OFE.

Acceso de MEM Sto Seleccione “Sto” para tener acceso a la memoria
memoria (almacenamiento | internao delatarjeta cuando la cdmara esté conectada
en masa USB), a una computadora con el cable USB. “PC” permite
PC (cdmara usar la cdmara como una cdmara USB/PC en directo
USB) (observe que los 8 aumentos y la falta de capacidad

de enfoque cercano limita su utilidad en la mayoria
de las habitaciones)

Borrar LSt +Trash | Ninguno-pulse Seleccione esta modalidad y pulse SNAP para borrar
ultimo Can SNAP para solamente la dltima foto tomada o el dltimo video
(tltimo borrar la tltima filmado. El contador se reducird en un nimero.
+basurero) | foto o el altimo
video
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Uso de las modalidades de operacién (negrita indica los ajustes implicitos)

Modalidad | Icono Ajustes Descripcién
Borrar todo | ALL+Trash | Ninguno- Seleccione esta modalidad y pulse SNAP para borrar
Can pulse SNAP todo el contenido de la memoria (el contador se
(todo para borrar reajusta a cero). Use esto después de descargar los
+basurero) todos los archivos, para borrar la memoria de modo que pueda
archivos de tomar nuevas fotos. Si se selecciona “Delete All” de
fotos y videos forma involuntaria. Simplemente espere unos segundos
y la cdmara volverd a la operacién normal.
Formato For+Trash Ninguno- Si estd usando una nueva tarjeta SD, o una previamente
Can pulse SNAP usada en otros dispositivos, recomendamos que
(formato para formatear | seleccione Format y pulse SNAP antes de empezar a
+basurero) la tarjeta o tomar fotos, de modo que la tarjeta estd configurada
la memoria con el archivo de datos correctos para esta cdmara.
interna Observe que el formateo de una tarjeta borra su contenido,
por lo que debe asegurarse de copiar primero los archivos
anteriores.
Tempo- Clock OFF La foto se toma después de una demora de 10 segundos
rizador (Reloj) (apagado) después de pulsar SNAP (en la modalidad de fotos fijas
automdtico o0 On normal). Esto se puede usar para no mover la cdmara
(encendido) por accidente cuando se pulse el botén SNAP. Si se

dispone del cable del obturador remoto, se debe usar
en vez del temporizador automdtico cuando la cdmara
esté montada en un tripode. El temporizador se cancela
de forma automdtica después de usarse.
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USO DE IMAGEVIEW CON SU COMPUTADORA:

1. La cdmara serd reconocida como un dispositivo de almacenamiento en masa USB (si se fija en “STO”
y no en “PC”), lo que significa que no se necesitan controladores especiales para todos los sistemas de
operacion posteriores a Windows 98 (Me, 2000, XP, Vista). Mac OS 9 y OSX también son compatibles.
Si tiene una PC que funciona con Windows 98, debe instalar el controlador encontrado en el CD-ROM
incluido ANTES DE CONECTAR LA CAMARA A SU PC.

2. Si tiene una computadora OS como la indicada arriba que cumpla con el almacenamiento en masa USB,

aparecerd un nuevo icono de disco en Windows Explorer (en “Mi PC”) como nuevo “Disco extraible”
después de enchufar el cable USB de Imageview. Los usuarios de Mac verdn aparecer el nuevo dispositivo
de disco en su escritorio.
Al hacer clic en el nuevo icono de disco se mostrard el contenido, una carpeta llamada “DCIM”. La
carpeta de imdgenes de dentro contiene sus fotos, almacenadas en forma JPEG (formato de archivo .jpg).
Se pueden ver, modificar, cambiar de nombre y guardar usando cualquier software de fotos o graficos
que acepte archivos .jpg. Si no tiene software que abra los archivos .jpg, debe instalar Roxio Photosuite
5 (Windows 98, 2000 6 XP solamente) del CD-ROM incluido. Vea las instrucciones en “Instalacién
del software”.

3. Después de haber copiado o abierto y guardado los archivos de fotos en la unidad de disco de su
computadora, puede desconectar la cimara Imageview (no desconecte NUNCA la cimara mientras se
estén transfiriendo los archivos a su computadora). Antes de desconectar, debe “expulsar” o detener el
“disco extraible” que representa la cimara para evitar un mensaje de error (no es necesario con Windows
XP).

4. Vea en las pdginas siguientes las instrucciones paso a paso para descargar sus fotos.

A PRECAUCION: Asegiirese de descargar todas las fotos/videos de la

memoria interna de su cdmara antes de quitar las pilas.
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Requisitos del sistema (minimo)

OS: Windows* 98/98SE/2000/ME/XP/Vista (PhotoSuite 5 no es compatible con Vista)

CPU: MMX Pentium® 200MHZ equivalente o mds répido (Pentium® ITT 500 MHz para PhotoSuite5™)
Memoria: 32MB minimo (64MB recomendada para PhotoSuite)

Tarjeta de video SVGA con 2MB de VRAM, pantalla de 800x600, color 16 bit High

Espacio de disco duro disponible de 200 MB (si se instala PhotoSuite)

Puerto USB interno

Instalacion del software

Si estd usando Windows 98, debe instalar controladores antes de conectar la cimara a su PC. Introduzca el
CD-ROM en la unidad de CD de su computadora; se cjecutard automdticamente y se mostrard la pantalla de
instalacion. Seleccione “Instalar controlador”, y después siga las instrucciones. Después de la instalacion, vuelva a
iniciar su computadora. Windows 2000, ME y XP no requieren controladores, ya que la cdmara usa la norma de
almacenamiento en masa USB, permitiendo el acceso a los archivos de fotos como si estuvieran almacenadas en un
disco duro externo. Para cualquier Windows OS, si atin no estd usando su software de edicién de fotos preferido,
puede instalar Roxio PhotoSuite” del CD-ROM. Asegtirese de leer las “Notas de publicacién” completamente,
observando cualquier recomendacién o temas potenciales para la configuracién de su PC y OS.

Nota: Con Windows Vista, puede encontrar mensajes de error o advertencia (‘falta un

archivo’, etc) durante la instalacion de PhotoSuite 5, pero al hacer clic en “OK” y sequir

adelante se debe permitir terminar la instalacién.

Transferencia de fotos y videos a su PC - Paso a paso
1. Asegtirese de que se haya instalado primero el controlador si estd usando Windows 98/98SE.
2. Conecte el cable incluido al puerto USB de ImageView, y después directamente a un puerto principal de USB
de su computadora sin usar los puertos USB del panel frontal/teclado o concentradores sin conectar.
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Transferencia de fotos y videos a su PC (continuacion)

3. La pantalla LCD indicard “STO” y la ImageView serd reconocida como un dispositivo estindar de
“almacenamiento en masa USB”. Esto significa que los archivos de la cdmara se pueden ver, modificar
o copiar ficilmente en su disco duro, simplemente como si se guardaran en un disco duro externo o
un CD-ROM. (Nota para los usuarios de Mac: Tal vez sea necesario seleccionar el acceso de memoria
“STO” y enchufar la ImageView mientras su LCD siga mostrando “STO” para que aparezca en el
escritorio de Mac como un disco “Sin titulo”. Vea “Uso de las modalidades de operacién”

4. (Este paso no es necesario con Windows XP, use simplemente las opciones de la ventana emergente
para ver, copiar o modificar sus fotos). Abra Mi PC o Windows Explorer. La cdmara se verd como un
nuevo “Disco extraible” con una letra de unidad de disco sin usar asignada a la misma. Haga doble clic
en este nuevo icono “Disco”, abra la carpeta “DCIM” de dentro, y después las carpetas de dentro de ésta
(“100MEDIA”, etc). Sus fotos/videos son los archivos de dentro, que tienen el prefijo “DSC” seguido
por un ndmero de 4 digitos, segtin se ha visto antes en la pantalla de la cdmara al revisar las fotos. Al
hacer clic en un solo archivo se debe mostrar una pequena imagen preliminar.

5. Haga clic en “Modificar>Seleccionar todo” (o haga clic en una foto, control+clic para seleccionar
multiples fotos) y después “Modificar>Copiar a la carpeta” (en los mends de Windows). Seleccione una
carpeta existente en su disco duro, como “Mis fotos”, o cree una nueva carpeta (“Vacaciones en Hawai”,
etc) y después haga clic en “OK” para transferir las copias de los archivos de fotos que desee.

6. Después de haber transferido las fotos a su disco duro, puede desconectar la cimara. Windows 2000
puede producir una advertencia de pantalla indicando que ha desconectado un dispositivo USB sin
detener o expulsar el “disco” primero (sus archivos de fotos no resultardn dafados). Si es asi, marque
el cuadro que afade un icono a su bandeja del sistema o barra de tareas. Después, la préxima vez
que termine de transferir las fotos, puede hacer clic en ese icono primero y “Parar el dispositivo de
almacenamiento en masa USB” antes de desconectar la cdmara. (En las computadoras Mac, debe
“expulsar” el “disco” sin titulo que apareci6 en su escritorio cuando la cdmara estaba conectada).
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Transferencia de fotos y videos a su PC (continuacion)

7. Ahora estd listo para abrir los archivos de fotos en cualquier software de edicién de fotos. Simplemente
use Archivo>Abrir y vaya a la carpeta donde almacené las fotos antes. Si estd usando PhotoSuite,
seleccione Archivo>Abrir foto y después use el ment desplegable “Buscar en” de la parte superior de la
ventana Abrir, seleccione “Mi PC”, seleccione su disco duro y haga doble clic en cualquier foto de la
carpeta donde haya copiado los archivos de la cdmara. También es posible abrir y trabajar con sus fotos
directamente desde la ImageView mientras esté conectada. Para hacer esto con PhotoSuite, primero
siga los pasos 1-3, después abra PhotoSuite, seleccione Archivo>Abrir foto y use el ment “Buscar en”
para seleccionar Mi PC, después seleccione el “Disco extraible” y abra las carpetas de dentro hasta que
obtenga los archivos de fotos JPEG. Si decide trabajar de esta forma, desde una cdmara conectada,
asegtrese de guardar la foto (cuando haya terminado de modificarla) en su disco duro y no en la memoria
o en la tarjeta de la cdmara. Para hacer esto en PhotoSuite, después de hacer clic en “Hecho”, responda
a “;Guardar cambios?” con “Si”, pero después conteste “;Desea reemplazar el archivo existente”? con
“No” y use el cuadro de didlogo “Guardar como” para guardar la foto modificada en una carpeta de su
disco duro (“Guardar en>Disco local”), no en “Disco extraible” (cdmara).

8. Si usted es nuevo en la edicién de fotos en una computadora, consulte en su ment de Ayuda
del software (PhotoSuite tiene una Ayuda integrada extensiva) recomendaciones sobre el uso de sus
caracteristicas. Ademds de ajustar el brillo, el contraste, la nitidez y el color de sus fotos, se puede
cambiar el tamafio de la foto para adaptarse al papel si estd imprimiendo, o guardar una versién de
resolucién mds pequefia, baja o intermedia para correo electrénico o insertar en documentos. Cuando
esté listo para guardar su archivo modificado, puede usar “Guardar como” y darle un nombre mds
descriptivo que “DSC___". Al hacer esto también se preserva el archivo original como reserva para
volver a abrirlo y modificarlo mds adelante. Asegtirese de haber transferido con éxito todas las fotos
deseadas para guardarlas antes de usar “Borrar todo” en su cdmara y dejar sitio a nuevas imdgenes.
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INSTRUCCIONES PARA LOS BINOCULARES

Sus binoculares Bushnell son un instrumento de precisién para darle muchos anos de vision
agradable. Esta parte del librito le ayudard a lograr el rendimiento éptimo explicando c6mo
pueden ajustarse los binoculares a sus ojos, y cdmo cuidar este instrumento. Lea detenidamente
las instrucciones antes de usar los binoculares.

AJUSTES DE LOS OJOS (Figura 1)

Cémo ajustar la distancia entre los ojos
La distancia entre los ojos, llamada distancia “interpupilar”, varfa
de una persona a otra. Siga estos pasos sencillos para lograr un

alineamiento perfecto de la lente con los ojos. STANCIA INTERPUPILAR
1. Sujete los binoculares en la posicién de observacién normal.
2. Sujete firmemente cada cilindro. Acerque o separe los cilindros hasta que vea un solo
campo circular. Reajuste siempre sus binoculares a esta posicién antes de usarlos.
Cémo ajustar segtin la intensidad de la visién
Como la vista varfa de una persona a otra, la mayoria de los binoculares de Bushnell tienen una
caracteristica de ajuste diptrico que permite ajustar con precisién los binoculares a su vision.
Siga las instrucciones de enfoque siguientes para su tipo de binoculares.

ENFOQUE
1. Ajuste la distancia interpupilar. (Figura 1)
2. Fije el “ajuste didptrico” (Figura 2) en cero y observe un objeto distante.

32

ImageView 118322 Eng+Span+Frn 3L32 32 2/19/08 11:22:14 PM



3. Mantenga abiertos los ojos en todo momento.

4. Usando una tapa de lente en la mano, cubra el objetivo
(delantero) del mismo lado de los binoculares que tenga el “ajuste
diéptrico”. Esto es normalmente el lado derecho. (El lado izquierdo
en los modelos con aumentos).

5. Use la perilla de enfoque central para enfocar un objeto distante

con detalle de precisién (por ejemplo, muro de ladrillo, ramas de
4rbol, etc.) hasta que aparezca tan nitido como sea posible.

6. Destape el objetivo en el lado di6ptrico, tape el otro objetivo y después observe el mismo
objeto.

7. Enfoque el mismo objeto observado usando el anillo de “ajuste diéptrico”. Se debe tener
cuidado, ya que al girar o forzar el ocular di6ptrico se pueden producir danos o hacer que
el ocular se desprenda del chasis.

8. Los binoculares deben ajustarse a sus ojos. El enfoque a cualquier distancia lejana o
cercana se puede lograr ahora simplemente girando la rueda de enfoque central. Anote el
ajuste didptrico para sus ojos como futura referencia.

OJERAS (Figura 3)

Sus binoculares Bushnell disponen de ojeras de goma disefiadas para I
—

su comodidad y para excluir luz extrana. Si lleva gafas normales o de (T —

sol, enrolle hacia abajo las ojeras. Esto le permitira acercar los ojos a las  —"—gmip—t—]
. A , ., L |
lentes de los binoculares, mejorando asi su campo de visién. OJERAS DE DISENADAS
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INSTRUCCIONES PARA EL CUIDADO DE LOS BINOCULARES
Sus binoculares Bushnell proporcionardn afios de servicio sin problemas si reciben el cuidado normal que les
darfa a cualquier instrumento éptico preciso. Los ImageView no son impermeables, y no deben exponerse a
ninguna fuente de humedad. Los dafios causados por el agua no estdn cubiertos por la garantfa.
1. Si sus binoculares tienen ojeras enrollables hacia abajo flexibles, gudrdelos con las ojeras hacia arriba.
Esto evita una fatiga y un desgaste excesivos en las ojeras en la posicion bajada.
2. Evite los golpes y las caidas.
3. Guarde en un lugar fresco y seco.
4. ADVERTENCIA: Mirar directamente al sol con los binoculares puede causar daiios permanentes en
los ajos.
5. No exponga nunca sus binoculares ImageView a ningtn tipo de liquido o fluido excesivos, ya que no
son a prueba de agua o neblina.
6. Saque las pilas de su ImageView si no va a usarlos durante un largo tiempo. (Asegtrese de descargar las
fotos de su cdmara antes de sacar las pilas de la misma).

LIMPIEZA
1. Retire el polvo o los residuos de la lente soplando (o use un cepillo suave para lentes).
2. Para quitar el polvo o las marcas de los dedos, limpie con un pafio de algodén suave frotando en
movimiento circular. El uso de un pafio tosco o un forzado innecesario puede rayar la superficie de la
lente y con el tiempo producir dafios permanentes. Un pafio de limpieza de “microfibras” (disponible en
la mayorfa de los distribuidores de fotos) es ideal para la limpieza rutinaria de su sistema dptico.
3. Para efectuar una limpieza mds completa, se pueden usar papeles y fluido de limpieza para lentes
fotogrdficas o alcohol isopropilico. Aplique siempre fluido al pafio de limpieza — nunca directamente
en la lente.
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(GARANTIA LIMITADA de DOS ANOS

Su producto Bushnell estd garantizado contra defectos de materiales y fabricacion durante
idos afios después de la fecha de compra. En caso de defectos bajo esta garantia, nosotros,
[a nuestra opcion, repararemos o sustituiremos el producto siempre que lo devuelva con
[portes pagados. Esta garantia no cubre defectos causados por el uso indebido, ni por un
imanejo, instalacio imi lizados por alguien que no sea un departamento
de servicio autorizado de Bushnell.

Aod,

[Nota deTa FCC:

[Este equipo ha sido sometido a pruebas y cumple conf
los limites establecidos para un aparato digital de Clase]
B, de acuerdo con la Parte 15 del Reglamento de laf
[FCC. Estos limites estan disefados para proporcionar|
[proteccion razonable contra interferencias perjudiciales

ICualquier envio que se haga bajo esta garantia deberé ir por lo si

1) Un cheque/giro postal por la cantidad de 10 délares para cubrir los gastos postales y de manejo

2) Nombre y direccién donde quiere que se le envie el producto

3) Una explicacién del defecto

4) Una prueba de la fecha de compra

5) El producto debe empaquetarse bien en una caja resistente para evitar que se dafie durante el
transporte, con los portes prepagados a la direcciUn que se muestra a continuacién:

[En EE.UU. enviar a:
Bushnell Outdoor Products
Attn.: Repairs

8500 Marshall Drive
ILenexa, Kansas 66214

En CANADA enviar a:

Bushnell Outdoor Products

Attn.: Repairs

25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

[En el caso de productos com{:rados fuera de Estados Unidos o Canadé, pongase en con-
tacto con su distribuidor local para que le den la informacion pertinente sobre la garantia.
[En Europa también puede ponerse en contacto con Bushnell en:

Bushnell Germany GmbH

European Service Center

Mathias-Briiggen-Str. 80
RMANY

D- 50827 Koln

Tel: +49 221 993568-0

Fax: +49 221 995568-20

Esta garantia le ofrece derechos legales especificos.
Puede que tenga otros derechos que varian de un pais a otro.
©2007 Bushnell Outdoor Products

fen una  instalacio idencial. Este equipo genera,
emplea y puede irradiar energfa de radiofrecuencial
5 si no se instalada y utiliza de acuerdo con la:
instrucciones, puede causar interferencia perjudicial
las radiocomunicaciones. Sin embargo, no garantizamos
lque no ocurriran interferencias en una instalacion|
len particular. Si este equipo causa interferencias
perjudiciales a la recepcion radial o televisiva, situacion|
lque puede determinarse apagando y encendiendo el
lequipo, se sugiere al usuario que trate de corregir tal
interferencia mediante uno o mds de las siguientes)
medidas:

| Reorientar o relocalizar la antena receptora.

| Incrementar la separacion entre el equipo y el receptor.
| Conectar el equipo a un tomacorriente en un circuit
diferente al que esta conectado el receptor.

| Consultar con el concesionario o un  técnic
experimentado  en  radio/television  solicitandole]
asistencia.

Con este equipo se debe usar un cable de interfaz}
blindado para cumplir con los limites para un aparat
digital de acuerdo con la Subparte B de la Parte 15 del

[Reglamento de la FCC.

FE€ C¢€

Las especificaciones y disefios estén sujetos a cambios sin ningtin aviso u obligacion por parte del fabricante.
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Frangais
AVERTISSEMENT

Veiller 4 bien télécharger toutes les photos de I'appareil AVANT d'enlever ou
de changer les piles, sauf si elles sont stockées sur une carte SD et non dans
la mémoire interne de I'appareil. Si l'appareil n'est pas équipé d'une carte SD,
il est conseillé de télécharger tous les fichiers photo courants avant de ranger
I'ImageView, au cas ou les piles se videraient durant une période d'inutilisation
prolongée.

AVERTISSEMENT

Ne PAS observer directement le soleil & travers les jumelles. Ceci peut
provoquer des lésions oculaires irréversibles.

REMARQUE : Pour réinitialiser l'appareil photo en cas de problémes ou si
U'affichage ne répond plus, enlever les piles pendant une minute au minimum puis
les remettre en place. Ceci peut entrainer lap perte de photos ou de vidéos stockées
dans la mémoire interne.
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A

Nous vous félicitons pour l'achat de vos jumelles Bushnell

ImageView”! Les jumelles Bushnell ImageView intégrent la

SIvIuv.L

technologie de la photographie numérique a des jumelles
compactes de haute qualité. Ceci vous permet d'observer des
manifestations sportives, la faune, des panoramas ou tout autre
sujet observé habituellement avec des jumelles et d'en conserver
une image au moyen de I'appareil photo numérique intégré. Ces
photos peuvent ensuite étre chargées dans votre ordinateur et
envoyées par courriel & votre famille et & vos amis, imprimées a
l'aide du logiciel fourni ou sauvegardées dans un album photo
pour un usage ultérieur. Avant d'utiliser ce produit, veuillez lire
les instructions contenues dans ce manuel et prenez le temps de
vous familiariser avec les différents éléments et fonctions de ce

produit.
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Description des jumelles

et de I'appareil photo

Ecran a
cristaux

liquides

Bouton Snap
(déclencheur) Mise au point

des jumelles

Bouton Mode/

Objectif
Marche

photo
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Configuration et fonctionnement de base

1. L'appareil photo est alimenté par deux piles alcalines, au lithium ou NiMh de format AAA
(non fournies). Placer les piles dans leur compartiment, avec les ressorts au contact des bornes
négatives (plates) de chaque pile. Un indicateur de charge des piles s'affiche dans le coin inférieur
droit de I'écran.

2. Insérer une carte SD (a « I'envers » avec les contacts métallique sur le dessus) dans le connecteur
si une capacité de stockage accrue est souhaitée. L'appareil accepte les cartes SD (pas les cartes
MMC) d'une capacité¢ de 1 Go maximum. L'appareil comporte une mémoire interne de 16
Mo pouvant contenir plus de 100 photos. L'utilisation d'une carte n'est pas toujours nécessaire.
Toutefois, le contenu de la mémoire interne est perdu si les piles sont enlevées ou déchargées, ce
qui n'est pas le cas des photos stockées dans une carte mémoire SD. Les cartes SD de 256 Mo,
512 Mo ou 1 Go de vitesse standard, disponibles dans la majorité des magasins d'informatique
ou d'électronique grand public, constituent un bon choix pour I'ImageView, en particulier s'il est
toujours utilisé en haute résolution.

3. Tenir le bouton MODE enfoncé jusqu'a ce que le voyant d'alimentation s'allume. L'appareil
photo s'éteint automatiquement au bout d'une minute si aucun bouton n'est enfoncé.
Remarque: lorsque l'appareil est raccordé & un ordinateur au moyen du cible USB fourni, l'appareil
photo s'allume automatiquement et est alimenté depuis ['ordinateur et non par les piles.

4. Tenir I'ImageView sans bouger et appuyer sur SNAP pour prendre une photo (ou commencer/
arréter de filmer si l'appareil est en mode vidéo). La mise au point de l'appareil est préglée pour
prendre des photos nettes de 11 m environ 4 l'infini.

5. Pour éviter tout mouvement de l'appareil lors de I'utilisation d'un trépied, brancher le
déclencheur 2 distance fourni dans la prise jack & coté du connecteur de carte SD et utiliser le
déclencheur a distance plutdt que le bouton SNAP pour prendre les photos.
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Utiliser les modes d'exploitation / Régler la date et I'heure

L'ImageView incruste la date et I'heure dans le coin inférieur droit des photos. Pour régler la
date et I'heure correctes, mettre I'appareil en marche puis tenir les boutons MODE et SNAP
enfoncés en méme temps jusqu'a ce que l'affichage clignote. L'écran affiche & présent les deux
derniers chiffres de I'année. Le cas échéant, appuyer sur le bouton MODE pour déplacer le
curseur sur le second chiffre. Appuyer sur le bouton SNAP pour faire avancer les chiffres
jusqu'a I'année en cours (« 07 » pour 2007, etc.). Appuyer ensuite sur MODE pour passer au
nombre suivant, 4 savoir le mois. Utiliser le bouton SNAP pour le régler sur le mois en cours.
Aprés le mois, I'écran affiche le jour, I'heure (format sur 24 h), les minutes et les secondes.
Poursuivre le réglage de la méme maniére 4 I'aide des boutons MODE puis SNAP. Une fois
tous les réglages de date et d'heure terminés, I'écran arréte de clignoter et revient a I'affichage
normal. Noter que la date et I'heure doivent étre réglées apres tout changement de piles.

L'ImageView est réglé par défaut en mode de haute résolution et haute qualité et il n'est pas
nécessaire de modifier les paramétres de MODE pour obtenir de bonnes photos en appuyant
simplement sur le bouton SNAP. Toutefois, avant de filmer une séquence vidéo, de supprimer
une ou plusieurs photos ou d'explorer d'autres options, il est conseillé de passer en revue
les options de mode disponibles présentées dans les pages qui suivent. Appuyer brievement
sur le bouton MODE pour passer d'un mode d'exploitation i l'autre dans I'ordre indiqué et
afficher I'icone du mode ainsi que son réglage courant. Utiliser le bouton SNAP pour choisir
le réglage souhaité pour le mode considéré. Si aucune modification n'est effectuée et que ni
SNAP ni MODE n'est enfoncé dans les 5 secondes, I'appareil revient & son mode normal de
fonctionnement et d'affichage.
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Utiliser les modes d'exploitation (réglages par défaut en gras)

Mode

Icone

Réglages

Description

Vidéo

Caméra vidéo

OFF, ON

Sélectionner ON au lieu de OFF pour mettre
l'appareil en mode vidéo. Attendre quelques
secondes que l'appareil revienne i l'affichage
normal et appuyer sur SNAP pour commencer
a filmer. Le compteur indique le temps écoulé.
Appuyer une nouvelle fois sur SNAP pour arréter
de filmer. Le compteur avance d'une unité,
indiquant que le fichier vidéo est enregistré.
Revenir au mode de configuration vidéo et
sélectionner OFF pour remettre 'appareil en
mode photo.

Qualité

Hqoulq

Hi (haute),
Lo (basse)

Sélectionner Hi (conseillé) ou Lo pour choisir le
niveau de compression de fichier, ce qui influe sur
la taille du fichier photo. Le réglage Lo permet de
stocker plus de photos dans la mémoire, mais &
une qualité réduite.

Résolution

Hi ou Lo

Hi (2,1 méga-
pixels), Lo (640
x 480 pixels)

Sélectionner Hi (conseillé) ou Lo, selon qu'on
souhaite obtenir de plus belles photos (Hi) ou
étre capable d'en stocker un plus grand nombre
(Lo).
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Utiliser les modes d'exploitation
p

Mode Icone Réglages Description

Fréquence 60 ou 50 60 Hz, 50 Hz Régler en fonction de la fréquence du courant secteur

secteur dans le pays. Ceci permet d'assurer une apparence
normale des photos et vidéos prises sous un éclairage
fluorescent.

Continu CT OFF, 3, 5 Sélectionner 3 ou 5 prises de vues pour prendre une

série rapide de photos plutdét qu'une prise de vue unique
lorsque SNAP est enfoncé (en mode photo). Pour
annuler, accéder de nouveau A ce mode et sélectionner

OFE
Acces MEM Sto (mémoire | Sélectionner Sto pour accéder A la mémoire interne ou
mémoire de masse a la carte lorsque I'appareil est raccordé 4 un ordinateur
USB), PC par le cable USB. Choisir PC pour utiliser 1'appareil

appareil USB) | directement en tant qu'appareil photo USB/PC (noter
pp: qu app: p

que le grossissement 8x et I'absence de mise au point
rapprochée limitent son utilité dans la majorité des

locaux)
Supprimer | LSt+ cor- Aucun- Sélectionner ce mode et appuyer sur SNAP pour
dernier beille appuyer sur supprimer uniquement la derni¢re photo ou vidéo
SNAP pour enregistrée. Le compteur recule d'une unité.

supprimer la
dernicre photo
ou vidéo

42

ImageView 118322 Eng+Span+Frn 3L42 42 2/19/08 11:22:16 PM



Utiliser les modes d'exploitation
p

Description

Sélectionner ce mode et appuyer sur SNAP pour effacer
tout le contenu de la mémoire (le compteur revient a
zéro). S'utilise apreés avoir téléchargé les fichiers, pour vider
la mémoire et pouvoir prendre de nouvelles photos. Si
« Supprimer tout » est sélectionné par accident, il suffit
d'attendre quelques secondes que l'appareil revienne en
mode de fonctionnement normal.

Si la carte SD est neuve ou a été utilisée précédemment
dans d'autres appareils, il est conseillé de sélectionner le
mode Format et d'appuyer sur SNAP avant de commencer
a prendre des photos, afin de configurer la carte suivant le
systéme de fichiers de données correct pour cet appareil.
Noter que le formatage d'une carte efface son contenu.
Veiller a4 bien sauvegarder d'abord tous les fichiers
existants.

Mode Icone Réglages
Supprimer | ALL Aucun-appuyer
tout +corbeille | sur SNAP pour
supprimer tous
les fichiers
photo et vidéo
Formater For Aucun-appuyer
+corbeille | sur SNAP
pour formater
la carte ou
la mémoire
interne
Retardateur | Horloge OFF ou On

La photo est prise au bout d'un délai de 10 secondes apres
actionnementdu bouton SNAP (en mode photo). Ceci peut
servir A éviter de faire bouger accidentellement I'appareil en
appuyant sur le bouton SNAP. Si le déclencheur  distance
est disponible, il est préférable de I'utiliser plutét que le
retardateur lorsque l'appareil est monté sur un trépied. Le
retardateur s'annule automatiquement aprés utilisation.
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UTILISER L'IMAGEVIEW AVEC UN ORDINATEUR:

1. L'appareil est identifié en tant que périphérique de mémoire de masse USB (s'il est réglé sur STO et non
sur PC), ce qui signifie qu'aucun pilote particulier n'est nécessaire avec les systémes d'exploitation autres
que Windows 98 (Me, 2000, XD, Vista). Il est également compatible Mac OS 9 et OSX. Avec un PC
sous Windows 98, veiller 4 installer le pilote trouvé sur le CD-ROM fourni AVANT DE BRANCHER
L'APPAREIL PHOTO SUR LE PC.

2. Si I'ordinateur fonctionne sous I'un des syst¢émes d'exploitation compatibles avec les mémoires de masse
USB indiqués ci-dessus, une nouvelle icone de disque s'affiche dans I'Explorateur Windows (sous « Poste
de travail ») en tant que nouveau « Disque amovible » apres branchement du cable USB de I'Tmageview.
Sur Mac, le nouveau périphérique s'affiche sur le bureau. Cliquer sur I'icone du nouveau périphérique
pour visualiser son contenu, un dossier nommé « DCIM ». Le dossier d'image a I'intérieur contient les
photos au format JPEG (fichiers .jpg). Elles peuvent étre visualisées, éditées, renommées et enregistrées au
moyen de tout logiciel de photos ou graphique prenant en charge les fichiers .jpg. En I'absence de logiciel
pouvant ouvrir les fichiers .jpg, installer Roxio Photosuite 5 (Windows 98, 2000 ou XP seulement)
depuis le CD-ROM fourni. Voir les instructions d'« Installation de logiciel ».

3. Aprés avoir copié ou ouvert et enregistré les fichiers de photos sur le disque dur de l'ordinateur,
I'Tmageview peut étre débranché (NE JAMAIS débrancher I'appareil photo alors qu'un transfert de
fichiers vers I'ordinateur est en cours). Avant de débrancher le cble, veiller & « éjecter » ou a arréter le
« disque amovible » représentant I'appareil photo afin d'éviter un message d'erreur (non nécessaire sous
Windows XP).

4. Voir les instructions détaillées de chargement des photos aux pages suivantes.

/_\ ATTENTION: Veiller 4 bien télécharger toutes les photos/vidéos de la
mémoire interne de l'appareil photo avant d'enlever les piles.
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Configuration requise (minimale)

Systéme d'exploitation : Windows® 98/98SE/2000/ME/XP/Vista (PhotoSuite 5 non compatible avec Vista)
Processeur : MMX Pentium® 200 MHZ et équivalents ou plus rapide (Pentium® 11T 500 MHz pour PhotoSu-
ite5™)

Mémoire : 32 Mo minimum (64 Mo conseillé pour PhotoSuite)

Carte vidéo SVGA avec 2 Mo de VRAM, écran 800 x 600 16 bits (65 536 couleurs)

200 Mo d'espace libre sur le disque dur (si PhotoSuite est installé)

Port USB interne

Installation du logiciel

Si l'ordinateur fonctionne sous Windows 98, des pilotes doivent étre installés avant de raccorder I'appareil photo.
Place le CD-ROM dans le lecteur CD de I'ordinateur ; il s'exécute automatiquement et I'écran d'installation s'affiche.
Sélectionner « Installer le pilote » et suivre les instructions. Apres 'installation, redémarrer I'ordinateur. Windows
2000, ME et XP ne nécessitent pas de pilote car I'appareil photo utilise la norme de mémoire de masse USB,
permettant d'accéder aux fichiers de photos comme s'ils étaient stockés sur un disque dur externe. Sous tout systéme
d'exploitation Windows, si aucun autre logiciel d'édition de photos n'est utilisé, installer Roxio PhotoSuite” depuis
le CD-ROM. VEiller & bien lire les conseils ou problémes potentiels liés a la configuration d'ordinateur et de systeme
d'exploitation considérée dans les « Notes de publication ».

Remarque : Sous Windows Vista, il est possible qu'un message d'erreur ou de mise en garde

(« fichier manquant », etc.) s affiche durant l'installation de PhotoSuite 5, mais le fait de
cliquer sur OK et de poursuivre devrait permettre d'achever l'installation.

Transfert de photos et de vidéos vers l'ordinateur - Pas a pas
1. Sous Windows 98/98SE, s'assurer que le pilote a préalablement été installé.
2. Brancher le cible fourni sur le port USB de I'mageView, puis directement sur un port USB principal de
I'ordinateur ; ne pas utiliser les ports USB de fagade, de clavier ou de concentrateur (hub) non alimenté.
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Transfert de photos et de vidéos vers l'ordinateur (suite)

3. L'écran de l'appareil affiche « STO » et I'ImageView est identifié en tant que périphérique de «
mémoire de masse USB ». Ceci signifie que les fichiers de l'appareil photo peuvent aisément étre
visualisés, édités ou copiés sur le disque dur, comme s'ils étaient stockés sur un CD-ROM ou un disque
dur externe. (Note pour Mac : il peut étre nécessaire de sélectionner le mode d'accés mémoire « STO
» et de raccorder I'ImageView alors que l'appareil affiche toujours « STO » pour qu'il apparaisse sur le
bureau du Mac en tant que disque « Sans titre ». Voir « Utiliser les modes d'exploitation »)

4. (Cette étape n'est pas requise sous Windows XD il suffit d'utiliser les options de la fenétre contextuelle pour
visualiser, copier ou éditer les photos). Ouvrir le Poste de travail ou I'Explorateur Windows. L'appareil
photo est identifié en tant que nouveau « Disque amovible » affecté d'une lettre de lecteur inutilisée.
Double-cliquer sur I'icone de ce nouveau disque, ouvrir le dossier « DCIM » a l'intérieur, puis les
dossiers qu'il contient (I00MEDIA, etc.). Les photos/vidéos sont les fichiers a I'intérieur. Ils comportent
le préfixe « DSC » suivi d'un nombre & 4 chiffres, affiché également sur I'écran de l'appareil lors de la
visualisation des photos. Un simple clic sur un fichier affiche une image d'apergu miniature.

5. Cliquer sur « Edition>Sélectionner tout » (ou cliquer sur une photo, CTRL+clic pour sélectionner
plusieurs photos), puis sur « Edition>Copier dans le dossier » (menus Windows). Sélectionner un
dossier existant sur le disque dur, comme « Mes images », ou créer un nouveau dossier (« Vacances Tahiti
», par ex.), puis cliquer sur OK pour transférer les copies des fichiers de photos souhaités.

6. Une fois que les photos ont été transférées sur I'ordinateur, I'appareil photo peut étre débranché. Il est
possible que Windows 2000 affiche une mise en garde indiquant qu'un périphérique a été déconnecté
ou éjecté avoir été arrété préalablement (ceci n'endommage pas les fichiers photo). Le cas échéant,
cocher la cas d'ajout d'une icone dans la barre des taches ou la barre d'état systéme. A 'issue du transfert
de photos suivant, il suffit de cliquer d'abord sur cette icone pour « Arréter le périphérique de mémoire
de masse USB » avant de débrancher I'appareil photo. (Sur les ordinateurs Mac, veiller i « éecter » le
disque « sans titre » figurant sur le bureau alors que l'appareil photo est encore branché.)
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Transfert de photos et de vidéos vers l'ordinateur (suite)

7. Les fichiers photo peuvent A présent étre ouverts dans tout logiciel d'édition de photos. Il suffit de cliquer sur
Fichier>Ouvrir et d'aller au dossier dans lequel les photos ont été enregistrées précédemment. Avec PhotoSuite,
sélectionner Fichier>Ouvrir une photo, puis utiliser le menu déroulant « Rechercher dans » au sommet de la fenétre
d'ouverture, sélectionner « Poste de travail », le disque dur, puis double-cliquer sur toute photo dans le dossier ot ont
été copiés les fichiers de I'appareil photo. Il est également possible d'ouvrir et de travailler avec les photos directement
depuis 1'TmageView alors qu'il est encore raccordé. Avec PhotoSuite, suivre d'abord les étapes 1 a 3, puis ouvrir
PhotoSuite, sélectionner Fichier>Ouvrir une photo et utiliser le menu déroulant « Rechercher dans » pour sélectionner
«Poste de travail », puis sélectionner « Disque amovible » et ouvrir les dossiers 2 I'intérieur jusqu'aux fichiers de photos
JPEG. En travaillant de cette maniére, depuis un appareil photo connecté, veiller & bien enregistrer la photo (une fois
éditée) sur le disque dur et non dans la mémoire ou la carte de I'appareil. Pour cela, dans PhotoSuite, aprés avoir cliqué
sur « Terminé », répondre & « Enregistrer les modifications ? » par « Oui » et & « Remplacer les fichiers existants ? » par
«Non » et, depuis la boite de dialogue « Enregistrer sous », enregistrer la photo éditée dans un dossier sur le disque dur
(« Enregistrer dans>Disque local »), et non sur le « Disque amovible » (appareil photo).

8. Les nouveaux utilisateurs d'un éditeur photo sont invités & consulter les instructions d'uilisation dans le menu d'aide
du logiciel (PhotoSuite offre une aide intégrée trés étendue). En plus des ajustements de luminosité, de contraste, de
netteté, la photo peut étre redimensionnée au format du papier pour I'impression ou enregistrée & une résolution
inférieure, basse ou moyenne, pour I'envoyer par courriel ou l'inclure dans des documents. Lorsque le fichier édité
est prét & étre enregistré, utiliser éventuellement « Enregistrer sous » pour lui attribuer un nom plus descriptif que «
DSC___ ». Ceci permet aussi de conserver le fichier d'origine en tant que copie de sauvegarde pouvant étre rouverte
et rééditée ultérieurement. Veiller & avoir bien transféré toutes les photos & conserver avant d'utiliser la fonction «
Supprimer tout » de |'appareil photo afin de faire de la place pour de nouvelles photos.
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INSTRUCTIONS DES JUMELLES

Les jumelles Bushnell sont un instrument de précision congu pour offrir de nombreuses années de
plaisir d'observation. Cette partic du manuel explique comment régler les jumelles en fonction des
yeux et comment assurer leur entretien, afin d'obtenir des résultats optimum. Lire ces instructions avec
attention avant d'utiliser les jumelles.

REGLAGES EN FONCTION DES YEUX (Figure 1)

Réglage de la distance entre les yeux
La distance entre les yeux, appelée « distance interpupillaire », varie
d'une personne 4 l'autre. Pour aligner parfaitement la lentille sur I'eil,
effectuer ce qui suit.

1. Tenir les jumelles en position d'observation normale.

2. Saisir fermement chaque fiit. Rapprocher ou écarter les flts I'un de

INTERPUPILLARY DISTANCE

l'autre jusqu'a ne plus voir qu'un champ circulaire unique. Veiller 2
toujours remettre les jumelles dans cette position avant de les utiliser.

Réglage en fonction de I'acuité visuelle
Comme I'acuité visuelle varie d'une personne a I'autre, la majorité des jumelles Bushnell comporte une

fonction de réglage dioptrique permettant un ajustement fin des jumelles 4 la vue de chacun. Suivre les
instructions de mise au point ci-dessous pour le type de jumelles utilisé.
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MISE AU POINT
1. Régler la distance interpupillaire. (Figure 1)
2. Placer le réglage dioptrique (Figure 2) sur zéro et observer un objet

distant. S
3. Garder les deux yeux ouverts en permanence. ‘\?mmj’\-
N =i~
4. A l'aide d'un capuchon de lentille ou de la main, couvrir la lentille =fa-=
d'objectif (avant) du méme c6té des jumelles que le réglage dioptrique. DIOPTER SETTING

1l s'agit habituellement du coté droit (coté gauche sur les modeles a
zoom).

5. A l'aide de la molette centrale, mettre au point sur un objet éloigné (mur en briques, branche d'arbre,
par ex.) de maniere a ce qu'il soit le plus net possible.

6. Découvrir la lentille d'objectif du coté du réglage dioptrique, couvrir I'autre lentille d'objectif puis
observer le méme objet.

7. Utiliser la bague de réglage dioptrique pour mettre au point sur le méme objet observé. Prendre garde
de ne pas tourner excessivement ni de forcer sur l'oculaire dioptrique car cela peut endommager ou
casser |'oculaire du chassis.

8. Les jumelles sont & présent réglées en fonction des yeux. Pour mettre au point sur des objets proches
ou éloignés, il suffit & présent de tourner la molette de mise au point centrale. Noter le réglage
dioptrique correspondant aux yeux pour s'en resservir ultérieurement.

EILLETONS (Figure 3)
Les jumelles Bushnell comportent des ceilletons en caoutchouc rabattables

congus pour offrir un grand confort et exclure la lumicre indésirable. Avec ST
‘es lunettes de soleil ou correctrices, rouler les ceilletons pour les rabattre. Ceci

approche les yeux des oculaires et offre un meilleur champ de vision.
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ENTRETIEN DES JUMELLES
Les jumelles Bushnell offriront des années de service sans probléme si elles font I'objet d'un entretien
courant semblable & celui de tout autre instrument optique de qualité. L'Imageview n'est pas étanche
et ne doit étre exposé & aucune source d'humidité. Les dommages de I'eau ne sont pas couverts par
la garantie.

1. Si les jumelles comportent des ceilletons souples rabattables, les dérouler pour ranger les jumelles. Ceci
évite les contraintes et I'usure inutiles des ceilletons lorsqu'ils sont en position rabattue.

2. Eviter de heurter ou de faire chuter les jumelles.

3. Entreposer dans un endroit frais et sec.

4. AVERTISSEMENT : L'observation directe du soleil avec les jumelles peut provoquer des lésions
oculaires irréversibles.

5. Ne jamais exposer les jumelles ImageView a un exces de liquide ou de fluide, car elles ne sont pas
étanches ni antibuée.

6. Enlever les piles des jumelles ImageView si elles ne doivent pas étre utilisées pendant une période
prolongée (veiller & bien télécharger les photos de I'appareil avant d'enlever les piles).

NETTOYAGE

1. Souffler la poussiere et autres débris des lentilles (ou utiliser un pinceau pour lentille A poils souples).

2. Pour éliminer la saleté ou les traces de doigts, nettoyer avec un chiffon doux en frottant d'un
mouvement circulaire. L'emploi d'un chiffon réche ou un frottement excessif peuvent rayer la
surface des lentilles et causer des dommages permanents. Un chiffon de nettoyage en « microfibre »
(disponible dans la majorité des magasins de photo) est idéal pour le nettoyage courant des verres.

3. Pour effectuer un nettoyage plus poussé, utiliser éventuellement des mouchoirs en papier de type photo
avec un liquide nettoyant pour objectif photo ou de I'alcool isopropylique. Toujours appliquer le
liquide nettoyant sur le mouchoir, jamais directement sur la lentille.
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[GARANTIE LIMITEE DE DEUX ANS

Votre produit Bushnell® est garanti exempt de défauts de matériaux et de fabrication
pendant deux ans aprés la date d'achat. Au cas ot un défaut apparaitrait sous cette
garantie, nous nous réservons l'option de réparer ou de remplacer le produit, a
condition de nous le renvoyer en port payé. La présente garantie ne couvre pas les
dommages causés par une utilisation, une mampur;uon, une installation incorrecte(s)
ou un entretien incorrect ou fourni par quelqu'un d'autre qu'un centre de réparation
agréé par Bushnell.

marque relative 2 la FCC (Commission fédérale des]
ltélécommunications)
‘e matériel a été testé et s'est révélé étre conforme aux limite
Idun dispositif numérique de classe B, conformément & o
ction 15 de la réglementation FCC. Ces limites ont éd
ftablies pour assurer unc protection raisonnable contrd
les parasites nuisibles dans les immeubles résidentiels|
C: matériel produit, utilise et peut émettre de I'énergicl

¢ des

il mese pas installé c

Tout retour effectué dans le cadre de la présente garantie doit étre a
articles indiqués ci-dessous :

1) un chique ou mandat d'une somme de 10,00 $ US pour couvrir les frais
d'envoi et de manutention

2) I nom et l'adresse pour le retour du produit

3) une description du défaut constaté

4)  la preuve de la date d'achat

5) Le produit doit étre emballé soigneusement, dans un carton d'expédition
solide, pour éviter qu'il ne soit endommagé durant le transport ; envoyez-le
en port payé, A l'adresse indiquée ci-dessous :

Aux Erats-Unis, envoyez : Au CANADA., envoyez i:

Bushnell Outdoor Products Bushnell Outdoor Products

Attn.: Repairs Attn.: Repairs

8500 Marshall Drive 25A East Pearce Street, Unit 1

Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

Pour les produits achetés en dehors des Etats-Unis et du Canada, veuillez contacter
votre distributeur local pour tous renseignements concernant la garantie. En Europe,
vous pouvez aussi contacter Bushnell au :

Bushnell Germany GmbH

European Service Center

Mathlas Bruggen -Sir. 80

D— 50827 Koln
Tel: +49 221 995568-0
Fax: +49 221 995568-20
La présente garantie vous donne des droits légaux spécifiques.
Vous pouvez avoir d'autres droits qui varient selon les pays.
©2007 Bushnell Outdoor Products

5 en

Jutilisé en conformité avec les instructions, il risque def
rovoquer des parasites nuisibles aux communications
adio. Toutefois, il est pas garanti que des parasites nd
e produiront pas dans une installation particuliére. Si cd
natéricl causait des parasites nuisibles 4 la réception radi
u télévision, qui peuvent ére dérerminés en mettant Id

Imatériel hors tension puis sous tension, luilisateur peu

fessayer de remédicr au probléme en appliquant I'une ouf

Iplusicurs des mesures suivantes :

| Réorienter ou déplacer 'antenne de réception.

| Augmenter la distance séparant le matériel du récepteur.

| Connecter le matériel 3 une prise de courant ou & un circui

ifférent(e) de celui (celle) auquel (2 laquelle) le récepteur es
reli.

| Consulter le concessionnaire ou un technicien radio/TV|

fexpérimenté.

lLe cible diinterface blindé doit étre utilsé avec le matéi
fin décre conforme aux limites d'un disposicif numérique)
lconformément 2 la sous-section B de la section 15 de laJ

réglementation FCC

FE C¢€

Les spécifications et conceptions sont
sujettes 3 modification sans préavis ni
obligation de la part du fabricant.
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OUTDOOR
TECHNOLOGY

INNOVATION THAT THRIVES OUTSIDE

For further questions or additional information please contact:

Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214
(800) 423-3537 * www.bushnell.com

©2007 Bushnell Outdoor Products
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